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Safety Notice

It is important that VMC’s equipment is installed and operated in such a way
that all applicable safety requirements are met. It is your responsibility as a
user to ensure that you identify the relevant standards and comply with them.
Failure to do so may result in damages to equipment and personal injury. In
particular, you should review the contents of the Setup Manual carefully before
installing or operating the equipment.

This equipment is not designed for placement in hazardous or explosive
environments that require Factory Mutual Approval.

Under no circumstances will the supplier of the equipment be liable for any
incidental, consequential, or special damages of any kind whatsoever,
including but not limited to lost profits arising from or in any way associated
with the use of the equipment or this Setup Manual.




Specifications

Internal Resolution

1,000,000 counts at 3mV/V

Display Resolution

Selectable (1/10,000 NTEP approval pending)

Input Sensitivity

1uV/graduation typical, 0.4uV/graduation minimum

Display Increments

Selectable x1, x2, x5, x10, x20, x50, x100

Decimal Point

Selectable 0 ~ 4

Display 7 Digits 7-Segment LED display, 14.2mm (0.56”) high, with
annunciators (7 LED lamps) for function select, Stable, Center Zero,
Net, Print, kg, Ib, and Low Battery display

Keyboard Standard - 6 button tactile keypad including Power On/Off key
Optional - 18 button tactile keypad including Power On/Off key

Audio Alarm Tone for key entry confirmation and low battery alarm

A/D Conversion Rate

7.5 updates per second

Load Cell Excitation
Voltage

9.7VDC or 5VDC selectable. Drive up to six 350 ohm load cells

Analog Input Range

0.2mV/V to 3.0mV/V maximum

Non-Linearity

0.01% of full scale or less

Over Capacity

Display “CAP OL” when exceeds full scale capacity

Tare

Standard - Pushbutton tare
Optional - Pushbutton tare, numeric tare entry & 10 predefined tare
recall

Auto Zero Tracking

Selectable to 3.0 d by 0.5 d step

Motion Window

Key in data 0..255 (1 =0.5d)

Calibration Method

Software — Menu driven prompting

Units of Measure

Selectable kg/lb/g/oz, up to 2 units displayable

RFI/EMI Protection

All signal and excitation lines filtered to —65db min. @ 500MHz

Filtering

Selectable digital filter

RS-232C data output

COM Port 1. Full Duplex or Bi-directional

COM Port 2. Simplex or Unidirectional (output only)

Selectable baud rates (1200,2400,4800,9600,19200), manual or auto
print, continuous data out or bi-directional communication

Remote Display

Standard — Remote only
Optional - Programmable as Main Indicator or Remote Display

Custom Print Format

Programmable, up to 119 characters for Custom Print Format and up
to 23 characters for Continuous Print Format

Set Points Standard - None
Optional - Selectable up to 2 Set Points for Low and High limit settings
Power 100/115VAC or 220/230VAC, 50-60Hz, 6VA with built-in Charger for

12VDC 2-2.3AH Rechargeable Sealed Lead Acid Battery
(Battery Dimension 67 (H) x 178 (W) x 34 (D) mm, is optional)

Current Consumption

100mA + 30mA per 350 ohm load cell

Operating Temp

-10 degrees C to + 40 degrees C

Relative Humidity

Maximum 90% RH, Non-condensing

Dimensions

150 (6”)H x 230 (9.1”)W x 100 (4”)D mm - ABS (Standard)
140 (5.5")H x 230 (9.1")W x 90 (3.5”")D mm - Stainless Steel (Optional)

Shipping Weight

2.71b (5.11b with optional battery) — ABS (Standard)
4.71b (7.11b with optional battery) — Stainless Steel (Optional)

Enclosure

ABS plastic Casing, Optional Stainless Steel, NEMA 4-X

Warranty

One Year Limited Warranty
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Status Indicators

| ]

Low Battery Indication

Pound Unit Indication

Kilogram Unit Indication

Print Status Indication

Net Mode Indication

Zero Status Indication

Stable Status Indication

There are 7 LED indicators just below the 7-segment weight display with the
following functions.

STB — (Stable Indicator) Indicates there is no weight motion on the
weighing platform.

ZERO- (Center Zero Indicator) Indicates the weight is at center of zero.

NET-(Net Weight Indicator) Indicates the currently displayed weight is a
net weight (a tare value is active).

PRINT-(Print Indicator) Flashes to indicate a successful print
transmission.

Kg-(Kilogram Indicator) Indicates the current weight unit is kilograms.
Lb-(Pounds) Indicates the current weight unit is pounds.
LOW BAT-(Low Battery) Indicates the battery is low during battery

operation. In the setup mode, the blinking of this LED is an indication to
enter a numeric value.
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Key Functions Group ‘A’

ON / OFF — Power switch.

ZERO - Zero button used to zero the indicator when the weight display is
stable.

TARE - Tares the indicator when the weight display is stable.

PRINT - Initiates a print transmission when the weight is stable.

G/N - Toggles the displayed weight between net and gross.

Select / Enter — Toggles between the selected units of measure.




Optional Key Functions Group ‘B’

‘0’ / F10 - Enters ‘0’, space, Double Quotation Mark or Back Slash depending
upon the current mode of operation.

‘1’ | F1 — Enters ‘1’ dash, period, forward slash, right and left parenthesis. This
key also represents Tare Register No. 1.
‘2’ F2 - Enters ‘2’,'A’, 'B’ or 'C’ depending upon the current mode of

operation. This key also represents Tare Register No. 2.

‘31 F3 — Enters ‘3’, ‘D’, ‘E’ or ‘F’ depending upon the current mode of
operation. This key also represents Tare Register No. 3

‘4’ | F4 - Enters ‘4’, ‘G’, ‘H’ or ‘I' depending upon the current mode of
operation. This key also represents Tare Register No. 4.

‘5’ | F5 - Enters ‘5, ‘J’, ‘K’ or ‘L’ depending upon the current mode of operation.
This key also represents Tare Register No. 5.
‘6’ | F6 — Enters ‘6’, ‘M’, ‘N’ or ‘O’ depending upon the current mode of

operation. This key also represents Tare Register No. 6.

"7’ | F7 - Enters 7°, ‘P’, ‘Q’, ‘R’ or ‘'S’ depending upon the current mode of
operation. This key also represents Tare Register No. 7.

‘8’ I F8 - Enters ‘8, ‘T’, ‘U’ or 'V’ depending upon the current mode of
operation. This key also represents Tare Register No. 8.

‘9’ | F9 — Enters ‘9", ‘'W’, ‘X', Y’ or ‘Z’ depending upon the current mode of
operation. This key also represents Tare Register No. 9

Clear — Clear entry or backspace depending upon the current mode of

operation.

Shift - Selects function keys or toggles alpha or numeric entry depending
on the current mode of operation.




Operating Instructions

Power ON Zeroing
Upon applying power the instrument will:

i) If the applied load is less than or equal to 2% of the calibration zero
point the instrument will establish zero and clear any tare values.

ii) If the applied load is greater than 2% of the calibration zero point the
instrument will display “- - - - - - - “. The load may be removed to
allow for automatic zeroing (above) or a manual zero may be
established by pressing the ‘Zero’ button. Note: If the instrument has
been configured to not allow for zeroing greater than 2% removing
the load will be necessary.

Zeroing
To zero the scale press the [Zero] button.

i) 2 % Zeroing

(1) This mode will allow pushbutton zero up to 2% of full scale
capacity. The available scale capacity will not be affected by the
zeroed amount.

i) 100 % Zeroing
(1) This mode will allow pushbutton zero up to 100% of full scale

capacity. The available scale capacity will be reduced by the
zeroed amount.

Pushbutton Tare (If enabled)
Place the object to tare on the scale and press the [Tare] button.
The weight will be established as tare and the weight mode will
switch to net.

Tare by Numeric Key (VC202 & VC203, if enabled)
Key in the tare value using the numeric keys then press [Tare].
In sealed applications this function is only permitted when the

gross weight is at zero.




O Programming Recall Tare Values (VC202 & VC203, if enabled)
(1) The VC202 & VC203 can maintain up to 10 predefined Tare
values.
(2) To program a tare value press [Shift] and then [8]. The display
will prompt [T 0-END] and then [t no. 1]
3) Key in the desired tare register number (1-10) and press [Enter].
4) The display will prompt [T XXX.XX]

5) Enter the desired tare value.

~ o~ o~ o~

6) To Exit programming tare registers, enter ‘0’ at the tare register
prompt.

0 Recalling a Tare Value (VC202 & VC203, if enabled)
Enter the desired tare register (1-10) then press the
[Select/Enter] key. In sealed applications this function is only
available when the gross weight is at zero.

O Preset Output Settings (VC202 & VC203, if enabled)

Press [SHIFT] then press [ 9],

The display will prompt [S XXX.XX]. Key in the Start value for

Set point 1 and press [Enter],

The display will prompt [E XXX.XX]. Key in the End value for

Set point 1 and press [Enter]

Repeat the above sequence for Set point 2.




Configuration Mode Key Functions

ZERO | Zero - Terminates the setup mode or exits numeric entry without changing the

»0¢ last value

,’3 Tare - Not in use.

PRINT | Print — Scroll forward through setup choices or increase the available
Q parameter value.

G/N_| G/N - Scroll backward through setup choices or decrease the available
Egﬁ parameter value.

Select/Enter - Accept the current value or choice. Pressing quickly this key
will advance next setup sub-menu. Use at the “END” prompt to save and exit

setup.

SELECT

The VC202 & VC203 allow numeric data to be entered via the Group B
keys.
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Setup/Configuration Mode Access

There are two ways to access the Setup/Configuration Mode:
1) Using the Calibration Jumper (JP1)
i) Turn off the instrument and insert Jumper 1 (JP1).
i) Turn the instrument on, the display will show the Audit Trail then
prompt for password entry [P 0].
iii) Enter the password “2001” and press the [Enter] key.
2) “Hot Key” entry if enabled (C1.2 is set to Enable.)
i) Press the [G/N] and [Enter] keys together while in normal operation
mode
ii) The display will show the Audit Trail then prompt for password entry
[P 0]

iii) Enter the setup/calibration password and press the [Enter] key.

Configuration/Calibration Mode

Category Selection:

The setup mode is arranged into major categories and their individual
selections. Upon entering the setup mode the display will prompt ‘C1’
indicating category ‘1’. Using the ‘Print’ and ‘G/N’ keys scroll through the setup
categories until the desired category is displayed. When the desired category
is displayed press the ‘Enter’ key to begin setup. Pressing ‘Zero’ while in the
category menu will prompt ‘END’, pressing ‘Enter’ at this prompt exits the
setup menu.

Setup Selection:

After entering the desired category use the ‘Print’ and ‘G/N’ keys to toggle
setup choices or alter setup values. Press ‘Enter’ to accept when the desired

value is displayed to save the value and advance to the next selection.

Note: Features requiring the Group B Function keys will not be available

when configuring the VC201

11
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Configuration/Calibration Menu Choices

C1 Misc.

» C1.1 [DPM]
» C1.2 [HKY]
» C1.3 [ATS]
» C14 [DTM]
» C1.5 [JPR]
C2 Key Enables
» C2.1 [UNE]
» C2.2 [TAM]
» C2.3 [TZE]
» C2.4 [PS1]
» C25 [PS2]
C3 Communications
C3.1 [ADR]
C3.2 [CHN]
C3.3 [BDR]
C3.4 [PAR]
C3.5 [TYP]
C3.6 [PFM]
C3.7 [PRM]
C3.8 [MIN]
C3.9 [CHW]
C4 Filter / Motion
» C4.1 [AVQG]
» C4.2 [MOW]
» C4.3 [MOT]
C5 Pre-Calibration
C5.1 [CUN]
C5.2 [SUN]
C5.3 [MET]
C5.4 [DP]
C5.5 [CAP]
C5.6 [DIV]
C5.7 [AZT]
C6 Calibration

» C6.1 [REF]
» C6.2 [PCAL]
» C6.3 [CAL]
C7 Calibration Tune
» C7.1 [TUN]
» C7.2 [DIR]

VVVVVVVYVYY

VVVYVYVVY

Display Mode

Hot-key

Auto Power Off Time

Power On Countdown Date/Time Settings Enable
Journal Printer: Sub Total, Grand Total Functions
Enable

Unit Toggle Key Enable

Tare Key Mode

Allow Keyboard Tare and Recall Tare at Zero
Preset Output 1 Enable

Preset Output 2 Enable

Instrument Address
Communication Channel (Port)
Baud Rate Selection

Data Bits and Parity

Serial Type

Print Format

Print Mode

Minimum Print Value

Weight Change Window

Average (Digital Filter)
Motion Window
Motion Time

Calibration Unit

Secondary Unit

Metrology Method

Decimal Position

Capacity

One Division Increment Size
Auto Zero Tracking

Reference Calibration Mode
Zero Point Calibration (Reference Calibration)
Span Calibration

Calibration Tune
Direction

C10 Print Formatting (Full Keypad Option Only)

» C10.1 [P1 CUST] Edit Custom Print Format

» C10.2 [P2 CONT] Edit Custom Continuous Output Format
» C10.3 [FMT END] Exit from Custom Format Editing

12




O Default settings are highlighted.

(S::It:cg:lt?z Values Description
C1 Firmware Function Settings
DPM | Display Mode
WET | Normal Weighing Mode Display
ADC | A/D Raw Counts Display
BAT | Battery Voltage Display
Secondary Remote Display Unit (Requires VC202 or VC203
RDP unit to b(_e setup as Main D.isplay Unit with C36 “‘PFM” = RDP)
Connecting the Remote Displays Communication Channel 1
(COM1) to the Main Displays COM1 allows remote key entry
C1.1 Secondary Remote Operation Unit. This setting will allow the
remote access of Display, Keyboard and Printer from/to a Main
Unit. Requires VC202 or VC203 unit to be setup as a Main
Unit with the Remote Printer Type on COM1 (C3.5 “TYP”=RP)
ROP | and a desired Print Format (C3.6 “PFM”=SIN, MUL or CPR)
Also requires Bi-directional Communication between Main and
Remote Units (COM1 «——COM1) and a Printer is attached to
this Remote Unit on COM2 with a Baud Rate setting in C3.3
HKY | Hot-key Enable (Allows front panel password entry to setup)
C1.2 D Disabled
E Enabled
ATS | Auto Power Shutdown (Off) Time (In Battery Operated Mode)
C13 1~255 | 1 =1 minute
0 Auto Power Shutdown Disabled
DTM | Power On Count Down Date/Time Settings Enable
C14 D Disabled
E Enabled
JPR Journal Printer: Sub Total, Grand Total Functions Enable
C1.5 D Disabled
E Enabled
C2 Function Keys Enable
UNE | Allow Unit Key Toggle
Cc2.1 D Disable
E Enable
C2.2 TAM | Tare Key Mode
D Disable
P Enable Push Button Tare Key (Default for VC201)
N Enable Numeric Tare Entry (Optional)
NP Enable Numeric Tare Entry and Pushbutton Tare (Optional)

13




Configuration

Values

Step Set Description
R Enable Recall Tare (Optional)
RP Enable Recall Tare and Pushbutton Tare (Optional)
C2.2
RN Enable Recall Tare and Numeric Tare Entry (Optional)
RNP Enable (Recall Tare, Numeric Tare and Push Button Tare)
(Default for VC202 & VC203)
TZE | Allow Keyboard Tare and Recall only at zero
Cc2.3 D Disable (Tare and Recall available at any weight)
E Enable (Tare and Recall available only at zero)
PS1 Preset 1 Output Enable
c2.4 OFF Disable
A0 Enable with normally Inactive Output Signal
A1 Enable with normally Active Output Signal
PS2 Preset 2 Output Enable
OFF | Disable
c25 A0 Enable with normally Inactive Output Signal
A1 Enable with normally Active Output Signal
C3 RS-232C Communications and Printings
Instrument Address (to be used with external RS-232 / RS-485
C3.1 ADR Level Converter)
0~255 | Default =0
CHN | RS-232C Communication Port Selection
CH Leave selection blank exit communications setup
C3.2 — | If CH1 or CH2 is selected continue Steps C3.3 through C3.9
CH1 Setup channel one
CH2 | Setup channel two
BDR | Baud Rate Selection
12 Baud Rate Set to 1200
c3.3 24 Baud Rate Set to 2400
48 Baud Rate Set to 4800
96 Baud Rate Set to 9600
192 Baud Rate Set to 19200
PAR | Data Bit Size and Parity Setting
c3.4 8N 8 Data Bit — No Parity
7E 7 Data Bit - Even Parity
70 7 Data Bit - Odd Parity
TYP | Serial Type — Serial or Printer
C3.5 SR Default setting for channel 1 (Serial)
PR Default setting for channel 2 (Printer)
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Configuration

Values

Step Set Description
Remote Printer — Available on channel 1 only. This setting will
behave as a Main Operation Unit that will redirect all printings
C3.5 RP to a Remote Printer (attached to the secondary unit) by using
) the Print Format setting in C3.6 and requires the secondary
unit to be setup as a Remote Operation Unit. (C1.1
“‘DPM”"=ROP)
PFM | Print Format
D Disable Printing
SIN Single Line Format (Gross, Tare, Net Wt.)
MUL | Multi-Line Print Format
c CON Continuous Print Format (<STX>XXXXX. XX<SP>Ib<ETX>)
3.6 <STX> = Start of Text, <SP> = Space, <ETX> = End of Text
CCO | Custom Continuous Print Format (Editable at C10.2)
CPR | Custom Print Format (Editable at C10.1)
Remote Display Format. This setting sets this unit to be a
RDP : :
remote master and requires secondary display to be setup as
the Remote Display (C1.1 “DPM” = RDP)
For C3.5 “TYP”=RP, only D, SIN, MUL or CPR choices are available
PRM | Print Mode
P Manually Print by pressing PRINT key
S Auto Print
RP Single manual print. A re-arming weight change will be
necessary to enable subsequent prints
RS Auto Print. Auto print again after re-arming weight change.
C3.7
HP Manual Print and hold display
HS Auto Print and hold display
Manual Print and hold display. Print again after a re-arming
HRP )
weight change
Auto Print and hold display. Print again after a re-arming
HRS .
weight change
CON | Continuous Printing (requires setting of C3.6 = CON or CCO)
MIN Minimum Print Value Setting (In terms of Divisions)
(Default = 0) Minimum printable weight in divisions
The weight must be equal to or greater than this many
C3.8 divisions to enable printing
0~255 | With MIN=0 and Print Mode C3.7 PRM=P or HP, multiple

manual prints can be performed without a requirement to
unload the scale

15




Configuration | Values Description
Setup Set
Re-arm weight in divisions
C3.9 CHW | Re-arming weight for print modes requiring a re-arm weight
change. (C3.7=RP, RS, HRP or HRS)
0~255 | Default Value = “0”
Print Response Retry Time-out for the bi-directional Remote
Tmo | Printer Communication
C3.10 This choice is only available when setting C3.5 “TYP”=RP
0 Disable (Use Internal Default Retry Time-out)
1~255 | 1=10 milliseconds (Should be at least 5=50ms)
C4 Filter/Motion
ca1 AVG | Average, Digital Filter
1~8 | Default =4 (8 = Maximum Stability)
MOW | Motion Window (1 = 0.5 Division)
C4.2 0 = No Motion Check
0~255 Default = 1
ca3 MOT | Motion Time (1 =0.1sec)
0~255 | Default =5
C5 Pre-calibration
CUN | Calibration Unit Selection
KG To Calibrate by kilogram “kg”
C5.1 LB To Calibrate by pound “Ib”
G To Calibrate by gram “g”
0oz To Calibrate by ounce “0z”
SUN | Secondary Conversion Weight Unit
KG To set secondary weight unit as kilogram “kg”
C5.2 LB To set secondary weight unit as pound “Ib”
G To set secondary weight unit as gram “g”
0oz To set secondary weight unit as ounce “0z”
MET | Metrology Method
C5.3 OIM OIML (F.S. Capacity + 9 divisions, 2% Zero Range, etc.)
USA | USA (F.S. Capacity + 5%, 100 % Zero Range, etc.)
DP Decimal Point Position
cs.4 0 ~4 | Default = 0, (No Decimal Point)
C5.5 CAP | Capacity Setting
Display will show “C XXX.XX”, Default = 50000 Ib
DIV Count-by
1,2, | Default = 1.
C5.6 5,10,
22,0%0, Select any one of 1, 2, 5, 10, 20, 50 and 100.
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Configuration | Values

Setup Set Description

AZT | Auto Zero Tracking Width (In Divisions)

OFF | Auto Zero Tracking function is OFF

C5.7 0.5D
To Select any one of 0.5D through 3.0D
3.0D
C6 Calibration
REF | Calibration Mode
C6.1 RC Standard Calibration (Zero Calibration and Span Calibration)
RS Span Calibration Only
RO Zero Calibration Only
PCAL Zero Calibration
C6.2 Display will show PCAL about 1 sec then “R XXXX.XX"
Insure the scale is unloaded and press ‘Enter’
CAL Span Calibration
Display will show “CAL” about 1 sec then “N XXXX.XX”
C6.3 Key in weight value to be used for Span Calibration (VC202 & VC203)
Scroll in the weight value to be used for Span Calibration (VC201)
Place the Weight on the scale and press ‘Enter’
Press Enter key to save the Calibration when “End” is displayed
C7 Calibration Tune
C71 TUN | Tune Calibration (Adjust Span)

0~255 | 1 =0.1 times the current value of the one division

C7.2 DIR Tune Direction

upP Adjust span upward

DOWN | Adjust span downward

(VC202 & VC203 Only) To Enter the Custom Print Format Procedure
With the C1 category displayed press ‘Shift’ then ‘0’

c10 Custom Print Formats (See details in the Customizing Print Format

section)
‘P1 CUST’

C10.1 ; .
Edit the Custom Print Format
‘P2 CONT’

C10.2 - 5 )
Edit the Custom Continuous Print Format
‘FMT END’

C10.3 —
Quit Print Format

17




Calibration Audit Trail

The audit trail consists of two event counters, one for the adjustment
(calibration) parameters (audit trail 1) and one for configuration parameters
(audit trail 2). The range will be (000 to 999) for each counter.

To view the audit counters press the ‘G/N’ and ‘Enter’ keys at the same time
while the instrument is in the normal weighing mode. The audit trail will be
displayed as long as the keys are held.

If the calibration jumper is installed the audit trail will be displayed momentarily
before the password prompt.

The audit trail format will be:
AXXX.YYY where:
XXX is audit trail 1 and YYY is audit trail 2.

Audit trail one will increment when changes are made to:
Pre-calibration data
Calibration
Calibration Tune

Audit trail two will increment when changes are made to:
Filter settings
Print related settings C3.6-C3.9,
Print Format
Weight related operation keys such as Tare mode

18




Input/Output Connections

Pin-Out Reference Table of HD1

HD1 is a 10-Pin Single Inline Header providing a Zero and 2-Set Point Outputs,

Each output can provide maximum continuous sinking current of 20mA from an internal
+5VDC power supply (Pin No. 9/10) or 50mA with an external +5VDC power supply.
These outputs are intended to drive Solid State Relays, driving mechanical relays may
present electrical interference problems

Pin No. 1 Reserved

Pin No. 2 Reserved

Pin No. 3 Reserved

Pin No. 4 Set point # 2 Output
Pin No. 5 Set point # 1 Output
Pin No. 6 Zero Output

Pin No. 7 Ground

Pin No. 8 Ground

Pin No. 9 +5VDC

Pin No. 10 + 5VDC

+ 5V Source
Relay
Zero
Set point-1 o—
Set point-2
GND [ GND (If external supply is used)
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Pin-Out Reference Table of HD2

HD2 is a 5-Pin Single Inline Header used for RS232-C Communication

Pin No. 1 TxD (Transmit Data RS-232C Communication Channel 1)

Pin No. 2 RxD (Received Data RS-232C Communication Channel 1)

Pin No. 3 Com (Signal Ground RS-232C Communication Channel 1)

Pin No. 4 Com (Signal Ground RS-232C Communication Channel 2)

Pin No. 5 TxD (Transmit Data RS-232C Communication Channel 2)

Pin-Out Reference Table of TB1

TB1 is a 5 Pin Screw Terminal used for the Load Cell Connection

Pin No. 1 +Excitation
Pin No. 2 +Signal
Pin No. 3 - Signal
Pin No. 4 - Excitation
Pin No. 5 Shield

Pin-Out Reference Table of TB2

TB2 is a 3 Pin Terminal Block used for the AC Supply Voltage Connection

Pin No. 1 AC Voltage Supply wire from step-down transformer

Pin No. 2 AC Voltage Supply wire from step-down transformer

Pin No. 3 Earth Connection

Pin-Out Reference Table of TB3

TB3 is a 2 Pin Terminal Block for DC Supply Voltage Connection to a Battery

Pin No. 1 +12VDC Supply from Battery

Pin No. 2 0VDC Supply from Battery

20




Jumpers, Headers and Terminal Blocks Location
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Error Messaqges

Error Messages Explanation

CAP OL Over Capacity, weight value exceeds the full scale capacity
ADC UL Input load cell signal is too low or reversed, load cell or load cell-cable is faulty
ADC OL Input load cell signal is too high, load cell or load cell-cable is faulty
NOT CAL Scale is Not yet Calibrated
RMT DSP \é\gglp?aeydisplayed on Remote Display Unit when there is no signal from the Main
RMT OPE \é\?!lptl):ydisplayed on Remote Operation Unit when there is no signal from the Main
SPAN OL Maximum calculated span count is greater than maximum ADC Chip count
LO BAT Insufficient battery voltage level. Need to re-charge the battery
_______ Display if Power On Zero fails. Need to unload the scale or optional press Zero
Key if power on zero weight is within allowable zero range
S.TOTAL Displayed_ beforfe enteriqg the password if Sub thal printing is_pending. Need to
press ‘Shift’+'Print’ to print the Sub Total and ‘Shift'+'G/N’ to print the Grand Total
G.TOTAL Displayeq before enteripg the password if Grand Total printing is pending. Need to
press ‘Shift'+'G/N’ to print the Grand Total
Jumper Settings
Reference Table For Jumpers
JP-1 Calibration Enable
JP-2 Reserved
JP-3 Not in use
JP-4 Not in use
JP-5 Not in use
JP-6 to set Excitation Voltage to 5V (Use to conserve power during battery operation)
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Customizing Print Format (Optional)
» Press [G/N] key and [Select/Enter] key together, Audit Trail will be displayed,
when released the display will show [P 0] and the 7" LED will flash, which
means you need to enter the numeric value password to access the setup mode.

» Key in the password [2] [0] [0] [1] and press [Enter], the display will show [C1 ]

» Press [Shift] then [0], [PRT FMT] will be displayed, then [P1 CUST] will be
displayed.
Here you can use the [PRINT] key or [G/N] key to browse the following three menus,
(1) [P1 CUST] » For Custom Print Formatting.
(2) [P2 CONT] » For Custom Formatting for Continuous Output.
(3) [FMT END] > to end the Custom Formatting and return to normal weighing mode.
select the menu by pressing the Enter key and continue the setting.

» The numeric characters (0, 1, ..., 9), all alphabets (A, B, ..., Z) and some other
characters are already assigned to the Group-B keys (Ref: Key Explanation page as
describe earlier) so these characters can be keyed in directly from Group-B keys.
(Example: for “1” » press [1] key,

for “A” > press [Shift] then press [2] key,
for “B” > press [Shift] then press [2] and press [Shift] key.
To confirm character entry, press [Enter] key after selecting the input

character).

U There will be a blinking LED just below one of the 7-segment display digits
which shows the active digit position or character insertion position.

» The characters or text to be printed out should be placed inside the double
quotation marks.
(e.g. “FlexWeigh” will print out as FlexWeigh )

» For Control characters or some other characters which cannot be used by the
front panel keys are to be keyed in by using the following format:
“Wxxx” (where: xxx is the ASCII code or extended ASCII code (0~255) in
decimal value of the character code to be printed)

» Following Command Codes are provided:
(1) “R” = Carriage Return

(2) \N” = Line Feed

(3) “E” = End of line (CR+LF) (e.g. “\E” = “\R\N” will be printed)

(4) “\Lx” = “X” Line Feeds (e.g. “\L3” = “\N\N\N” = 3 Line Feeds will be printed)
(5) \Sx” = “x” Spaces (e.g. “\S4” = 4 spaces will be printed)

(6) \CX.Y” = Repeat printing a character X for a total of Y characters, X can be
“Xxx” form (e.g. \C=.16" = Prints “=" for 16 characters or \C\42.16 = Prints “*”
for 16 characters)

» Weight Format Command (WX.Y)
X = Weight Type (0 = Net, 1 = Gross, 2 = Tare)
Y = Field Width (Includes “.” if any)

» Weight Unit Command (U)
Appends the current unit of measurement to the printed weight and optional tare

entry flag.

(1) “Mkg™A”? For Pushbutton Tare, Gross or Net Weight. (kg = current unit, #
= space)

(2) “"kg(K)” For Keyboard Tare or Recall Tare Weight.
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Delay Command (DX)
Delay after print which is normally placed after CR/LF, where X = Delay Time

(1 =0.1 sec).

Example: W1.8U = Print the gross weight right justified with a field width of 8
followed by the current units: e.g. “ 3456.78 kg ”

To Print the current editing print format press [Tare] key then select [Print].

To Erase the current editing print format press [Tare] key then select [Erase].
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Print Output Formats & Printout Samples

U Single Line Print Output Format (C3.6 = SIN)
Gross XXX XXXXXAKGMAMT are AX XXX XXX XAKGAMAAMN et AXX XXX XXX Akg<NL>

Where: » = Space, X = Number (‘0’ to ‘9’) or Leading Space or Decimal Point or
Minus

Single Line Format Output Sample

Gross  29.999 kg Tare 9.999 kg Net 20.000 kg
Gross 3000.00 Tb Tare 5.00 Th(K) Net 2995.00 1b
Gross 22000 kg Tare 2000 kg Net 20000 kg

U Multi-Line Print Output Format (C3.6 = MUL)

Gross " XXXXXXXXAkgMA<NL>ATare AXXXXXXXXAkgAMAKNL>AMN et AXX XX XXX XX kg
AM<2XNL>

Multi-Line Format Print Output Sample

Gross  30.000 kg Gross  30.000 kg
Tare 10.000 kg Tare 10.000 kg(K)
Net  20.000 kg Net  20.000 kg

U Continuous Print Format (C3.6 = CON)
<STX>XXXXXX XXAKGAMA<ETX>

O Default Custom Print Format Sample (C3.6 = CPR)
“GROSS\58\S3"W1.8U"\R\N TARE\58\S3"W2.8U"\R\N NET\58\S3"W0.8U"\R\L2”

Corresponding Print Output is:

Gross: 30.000 kg Gross: 30.000 kg
Tare: 10.000 kg Tare: 10.000 kg(K)
Net: 20.000 kg Net: 20.000 kg

U Default Custom Continuous Print Format Sample (C3.6 = CCO)
“\2"W0.8U"\3”

Corresponding Print Output is:
<STX>XXXXXX XXAKGMA<ETX>

U Note:
A ‘(K) is printed after a keyboard entry or recalled tare weight.
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Journal Print Format & Printout Sample

Journal Print Format is enabled by the settings: 1) Custom Print Format Type (C3.6
“‘PFM” = CPR) with the proper Journal Print Format in C10.1 as will be described
below, 2) Date/Time Setup Enable (C1.4 “DTM” = E) and 3) Journal Print Feature
Enable (C1.5 “JPR” =E) .

Following commands are specially provided for Journal Printer Print Formats:

» Journal Print Format Commands (FX)
Where X = Format No. 1 to 5.
Each of the following command defines the format header or a start position of
print format.
F1 = Start of Main Title Format
F2 = Start of Sub Title Format
F3 = Start of Batch Weighing Format
F4 = Start of Sub Total Format
F5 = Start of Grand Total Format
Note: At the end of each format, “CR/LF” pair will be printed, except at the end of F5.

» Code and Number Format Commands (NX)
Where X = Format No. 1 to 4.
Each of the following command represents the Code or Numeric Data to be printed.
N1 = Product Code (10 Alpha-Numeric Characters)
N2 = Consecutive No. (5 Numeric Characters)
N3 = Sub Total Counts (5 Numeric Characters)
N4 = Grand Total Counts (5 Numeric Characters)

» Weight and Unit Format Commands (WX.Y.U)
X = Weight Type (0 = Net, 1 = Gross, 2 = Tare,
3 = Sub Total Weight, 4 = Grand Total Weight).
Y = Field Width  (Includes “.” if any)
U = Appends the current unit of measurement to the weight and optional tare entry
flag.
(1) U = 0: Not print current unit of measurement. (Same as W.X.Y)
(2) U = 1: Appends the current unit of measurement (“*kg”) to the printed weight.
(3) U =2: Appends as described in (2) but with 3 additional characters of tare
entry flag:

(a) “MA” For Pushbutton Tare, Gross or Net Weight (* = Space).
(b) “(K)” For Keyboard Tare or Recall Tare Weight.
0 Example: Following will print the net weight right justified with a field width of
8 and will finally print a different type of optional current unit of measurement
description:
W0.8.0 = without current unit: e.g. “ 3456.78” (same as WO0.8).
W0.8.1 = 1 space and 2 characters of current unit: e.g. “ 3456.78 kg”.
W0.8.2 = 1 space and 2 characters of current unit with 3 extra spaces of tare
flag. e.g.* 3456.78 kg ” (same as W.0.8U).
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» Time Format Commands (TX)
Where X = Time Format No. 1 to 8 as follows:

Command Format Print Out
T1 H:MM 2:13
T2 HH:MM 02:13
T3 H:MM:SS 2:13:00
T4 HH:MM:SS 02:13:00
T5 H:MM AM/PM 2:13 AM
T6 HH:MM AM/PM 02:13 AM
T7 H:MM:SS AM/PM 2:13:00 AM
T8 HH:MM:SS AM/PM 02:13:00 AM

Command Format Print Out
H1 D/M/YYYY 2/3/2004
H2 D/M/IYY 2/3/04
H3 DD/MM/YYYY 02/03/2004
H4 M/D/YYYY 3/2/2004
H5 M/D/IYY 3/2/04
H6 MM/DD/YY 03/02/04
H7 MM/DD/YYYY 03/02/2004
H8 YY/MM/DD 04/03/02
H9 YYYY-MM-DD 2004-03-02
H10 D MMM YYYY 2 Mar 2004
H11 DD-MMM-YY 02-Mar-04
H12 DD-MMM-YYYY 02-Mar-2004
H13 DDD D MMM YYYY Tue 2 Mar 2004

O Custom Journal Print Format Sample (C3.6 = CPR)

Editable at C10.1 Custom Print Format as follow:

Main Title

°F1"\E\C=.16\E°

> VMC\E-

A\C=.16\E"~

Sub Title
°F2H1T2"\E-
°CODE: "N1-

Batch Weighing
°F3N2W0.8.1°

Sub Total
°F4"\C-.16\E"~
°N3W3.8.1"\R\L2"-

Grand Total

°F5"TOTAL:\S5"N4"\E"°

°W4.13.1"\R\L4"

Note:
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> Date Format
Commands (HX)

Where X = Date
Format No. 1 to 13 as
follows:

VMC

28/5/2004 13:18
CODE: 1234567890

1 200.0 kg
2 200.0 kg
2 400.0 kg

28/5/2004 13:20
CODE: ABC1234567

1 400.0 kg

2 200.0 kg

2 600.0 kg
TOTAL: 4
1000.0 kg




7
0‘0

The actual custom print format that will be shown inside the “C10.1” edit buffer
is the continuous extraction of any characters located between the two
delimited symbols “” of the above multi-line print format sample.

To quickly jump to the start of each format (F1 to F5) during editing the custom
print format, press [Shift] key then press [>] or [<] key to jump to the next or
previous journal print format position respectively.

The right figure shows the print output of the above custom journal print format

sample.
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Journal Print Format Key Operation

Following procedures are only available when the Custom Print Format contains the
specific Journal Print Format as described in the previous section. It requires 3 main
printing steps to complete the Operation, i.e. (1) Batch Weighing, (2) Sub Total and
(3) Grand Total as follows:

How to print the Batch Weighing:
1) Before starting the first weighing of each new batch, enter the Product Code (10
alpha-numeric characters) by using the Function Key [F1] (Press [Shift] then

press [1]).

Note:

= Enter the Product Code in the same way as editing the Custom Print Format in
C10.1.

= To Delete all characters of Product Code at once, press [Shift] then press
[Clear].

= The Function Key [F1] is automatically enabled when the Sub Title Format
(F2) contains the Product Code (N1) command.

2) Perform a consecutive batch weighing as usual, i.e. when the weight becomes
stable, either Manually Print or an Auto Print should be issued depending on the
setting in C3.7 “PRM”. Following conditional print formats will be printed:

(i) Main Title Print Format (F1):
Printed only once at the start of the First Batch Weighing. Normally the
Company Name is printed here.
(i) Sub Title Print Format (F2):
Printed only once at the start of each New Batch Weighing. Normally
Date/Time and Product Code is printed here.
(iii) Batch Weighing Format (F3):
Once the above two conditional formats are printed, each weighing in a batch
will be printed consecutively. Normally Consecutive No. and Net Weight with
current selected unit are printed here. After printing, the following data will be
updated:
a) Consecutive No. (N2) will be increased by one.
b) Sub Total Count (N3) will be increased by one.
c) The Printed (Net) Weight (WO0) will be accumulated to the Sub Total
Weight (W3)
3) Continue the next consecutive weighing as described in step (2.iii) if required.
4) For the last Batch Weighing, issue the Sub Total Data Print as shown below.

How to print the Sub Total:

After printing the last weighing of each batch, issue the Sub Total Data Print as

follows:

1) Press [Shift] then press [Print].

2) The Sub Total Print Format (F4) Data will be printed. Normally line separator,
Sub Total Data e.g. Accumulated Counts (N3) and Accumulated Weight (W3) will
be printed here.

3) After printing the Sub Total Data, the following will be reset:

a) Consecutive No. (N2) will be reset to one.
b) Sub Total Count (N3) will be cleared to zero
c) Sub Total Weight (W3) will be cleared to zero.

4) Continue the next batch with the above How to print the Batch Weighing if
required.

5) For the last batch Sub Total printing, issue the Grand Total Data Print as shown
below.
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How to print the Grand Total:

After the last batch Sub Total Data Print, issue the Grand Total Data Print as follows:

1) Press [Shift] then press [G/N].

2) The Grand Total Print Format (F5) Data will be printed. Normally Grand Total
Data e.g. Accumulated Counts (N4) and Accumulated Weight (W4) will be printed
here.

3) After printing the Grand Total Data, the following will be reset:

a) Grand Total Count (N4) will be cleared to zero
b) Grand Total Weight (W4) will be cleared to zero.

4) Restart the new Operation with the above “How to print the Batch Weighing” if

required.

Note:

% When the Batch Weighing Operation is in process, the Print LED lamp will be
always turned ON to indicate that the Sub Total data or the Grand Total data is
pending.

During in this period, the following Operations are temporary disabled:
= Unit Key Toggle is disabled
= Configuration Setup is disabled

< After printing the Sub Total and Grand Total data, the Print LED lamp will be
turned OFF, the Operations of Unit Key Toggle and Configuration Setup will
be enabled again.

Date and Time Settings Operation

Date and Time Settings can be enabled with the configuration setting in C1.4 “DTM” = “E”.
If enabled, the following description explains how to setup the Date and Time
operation.

Once the power on count down has finished; the date and time settings procedure will
be prompted to allow the operator to enter the current date and time that can be
printed out by the custom date or time formats defined in the editable custom print
format at C10.1.

These date and time formats are specially provided for a journal print format to print
the current date and time, normally as a part of the Sub Title before the starting of
each batch weighing.

The date or time data is generated from the system clock of the indicator. As long as
the indicator is on, the internal clock will keep running and automatically support the
calendar features as follows:

» Number of days in each month.

» Day of week (e.g. Sun, Mon, Tue, Wed, Thu, Fri, Sat)

» Leap year (The year with 29 days in February)
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How to setup the current Date and Time:
The following are the sequence of date and time setups, just after the display count

down finished:

After “DATE” displayed about 1 second, enter the current date as follows:

LED Display Description Data Range
YRS XX Enter the current Year | XX = 00 to 67 for Year = 2000 to 2067
MON XX Enter the current XX=1t012
Month
DAY XX Enter the current Date | XX =1 to 31

After “TIME” displayed about 1 second, enter the current time as follows:

LED Display Description Data Range
HRS XX Enter the current Hour | XX =0 to 23 (Setup as 24 Hour Format)
MIN XX Enter the current XX =0to 59
Minute
SEC XX Enter the current XX =0to 59
Second

How to momentarily display the current Date and Time:

During the normal weighing operation, press [Shift] then press [Enter]. The display
will show the current time (5 seconds) then will show the current date (3 seconds) as
shown in the following formats:

> Current Time Format “ HH.MM.SS”
Where: HH = Hour, MM = Minute, SS = Second

» Current Date Format ‘DD.MM.YY.W”
Where: DD = Day, MM = Month, YY = Year,

Fri, 6 = Sat)

W = Day of week (0 = Sun, 1 =Mon, 2 =Tue, 3=Wed, 4 =Thu, 5=
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Setup Record Table

Owner >
Scale Model > Firmware Version >
Serial Number > Date of Purchase >
Capacity & Division > Setup Date >
Application Type >
Load cell Brand & Model > Load cell Capacity >
No. of Load cell > Load cell Sensitivity >
C1.1 > Display Mode > C1.2 > Hot-key >
C1.3 > Auto-Power Off > C1.4 > Date-Time Enable >
C1.5 > Journal Print >
C2.1 > Unit Key Toggle > C2.2 > Tare key mode >
C2.3 > Tare key at zero > C2.4 > Preset 1 Enable >
C2.5 > Preset 2 Enable >
C3.1 > Instrument >
RS-232C Communication Channel 1 Settings C3.3 > Ch-1 Baud Rate >
C3.4 > Ch-1 Parity > C3.5 > Ch-1 Type >
C3.6 » Ch-1Print Format » C3.7 > Ch-1 Print Mode >
RS-232C Communication Channel 2 Settings C3.3 > Ch-2 Baud Rate >
C3.4 > Ch-2 Parity > C3.5 » Ch-2 Type >
C3.6 » Ch-2 Print Format > C3.7 > Ch-2 Print Mode >
C3.8 » Minimum Print > C3.9 > Wt.Change >
C3.105 Print Retry Time- >
C4.1 > Average > C4.2 > Motion Window >
C4.3 > Motion Time > C5.1 > Calibration Unit >
C5.2 > Secondary Unit > C5.3 > Metrology >
C5.4 > Decimal Point > C5.5 > Capacity >
C5.6 > Division size > C5.7 » Auto Zero >

C10.1 > P1 CUST

C10.2 > P2 CONT

Set point 1, Start Value

Set point 1, End Value

Set point 2, Start Value

Set point 2, End Value

REMARKS
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ASCI| Character Set

ASCIl Character Set
Dec | Hex | Char ]| Dec | Hex | Char ]| Dec | Hex | Char | | Dec | Hex | Char
0000| 00 | NUL ||0032]| 20 SP 0064 | 40 @ 0096 | 60 )
0001| 01 | SOH ||0033| 21 ! 0065| 41 A 0097 | 61 a
0002| 02 | STX ||0034| 22 " 0066| 42 B 0098 | 62 b
0003| 03 | ETX | |0035]| 23 # 0067 | 43 c 0099| 63 c
0004| 04 | EQT | |0036] 24 $ 0068] 44 D 0100| 64 d
0005| 05 | ENQ | |0037]| 25 % 0069| 45 E 0101 | 65 e
0006| 06 | ACK | |0038| 26 & 0070| 46 F 0102| 66 f
0007| O7 | BEL ||0039| 27 ' 0071| 47 G 0103| 67 g
0008| 08 BS 0040| 28 { 0072| 48 H 0104 | 68 h
0009| 09 HT 0041| 29 ) 0073| 49 [ 0105| 69 [
0010] OA NL 0042] 2A * 0074] 4A J 0106| GA i
0011| OB VT 0043| 2B + 0075| 4B K 0107 | 6B k
0012| oC FF 0044| 2C . 0076| 4C L 0108| &6C |
0013| 0D CR 0045| 2D - 0077| 4D M 0109| 6D m
0014| OE | SO o046| 2E . 0078| 4E N 0110| 6E n
0015| OF Sl 0047| 2F ! 0079| 4F 0 0111| 6F o
0016| 10 | DLE | |0048]| 30 0 0080| 50 P 0112 70 p
0017 11 DCA1 0049 31 1 00811 51 Q 0113 71 g
0018| 12 | DC2 | |0050| 32 2 o082| 52 R 0114 | 72 r
0019| 13 | DC3 | |0051| 33 3 0083| 53 S 0115 73 5
0020 14 | DC4 | |0052| 34 4 0084| 54 T 0116| 74 t
0021| 15 | NAK | |0053| 35 5 0085| 55 U 0117| 75 u
0022| 16 | SYN | |0054]| 36 6 0086| 56 Vv 0118 76 v
0023| 17 | ETB | |0055]| 37 7 0087 57 W 0119 77 W
0024| 18 | CAN | |0056]| 38 B8 0088| 58 X 0120 78 X
0025| 19 EM 0057| 39 9 0089| 59 Y 0121 79 y
0026| 1A | SUB | |0058] 3A : 0090] 5A z 0122 TA z
0027| 1B | ESC | |0059]| 3B : 0091| 5B [ 0123| 7B {
0028| 1C FS 0060| 3C < 0092| s5C \ 0124| 7C |
0029| 1D GS 0061| 3D = 0093| 5D ] 0125| 7D }
0030| 1E RS 0062| 3E > 0094| 5E A 0126| TE ~
0031| 1F UsS 0063| 3F 7 0095| 5F B 0127]| 7F | DEL
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Password
The calibration/configuration password is:

2001
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